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  CHAPTER 1                                      

1.1 Introduction 

To perform seismic evaluation of a residential building using pushover analysis and provide 

method for retrofitting of members in case the members fail under the load combinations 

prescribed in IS 1893-2002.The methodology adopted to perform the seismic evaluation of 

the building requires an understanding of equivalent lateral force procedure also recognized 

as equivalent static procedure in literature. And in depth knowledge of ETAB software is 

required as the building was modeled in ETAB and post analysis data obtained from it was 

used in the analysis of the structure. The various hinges formation and capacity curve of 

members was calculated as per FEMA and ATC-40 approach to analyze the seismic stability 

of the structure under the various load combinations in accordance with IS 1893-2002 (part 

1) .Suitable retrofit measures were proposed for beams and columns failing in shear and 

flexure  

 

1.1.1Scope of the study:  

In the response spectrum procedure of seismic analysis, the seismic loads are applied to the 

centre of mass of the storey, but in ETAB, I have assumed the seismic loads to be nodal loads 

and applied it to nodes dividing the total lateral storey loads in equal proportion per node and 

not at the exact centre of mass of the storey. While considering retrofit measures for the 

structure, analysis of structure post concrete jacketing was kept outside the scope of this 

study. 

1.1.2 Basics of Seismic evaluation: 

Response spectra: 

Interaction between ground accelerations and structural systems are reported through 

response spectrum. Plots peak responses over time for a range of single-degree-of-freedom 

(SDOF) systems subjected to a particular base motion as a function of their natural frequency 

ωi, or vibration period Ti. The resulting plot can then be used to pick off the response of any  

linear system, given its natural frequency of oscillation. Response spectra are used by 

earthquake engineers for analyzing the performance of structures in earthquakes, since many 

behave principally as single degree of freedom systems. The purpose of the response 

spectrum is to know the response of a single degree of freedom system if the ground moves 

as per the given accelerogram. An accelerogram is the recording of the acceleration of the 

ground during an earthquake. Response may mean any quantity like acceleration, velocity or 

deformation
[1,2]

. 

http://en.wikipedia.org/wiki/Linear
http://en.wikipedia.org/wiki/Linear
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The figure below shows the accelerogram for the earthquake that hit the El-Centro city in 

Imperial valley of California. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1: Accelerogram for the earthquake affecting El-Centro city in 1940 
[3]

 

 

The strength depends on the following factors: 
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 Frequency 



 Maximum velocity 



 Maximum displacement 



 Maximum acceleration 

Design spectrum must also be accompanied by: 

Load factors, as different choices of load factors will lead to different seismic safety of the 

structure. Damping, variations in the values of damping used in the design will affect the 

design force. Method of calculation of natural period of the structures, which depends upon 

the assumptions made while modeling.
[2,4]
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                    Figure 2: A typical design spectrum 
[5]

 

 

Pushover analysis  
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The pushover analysis of a high rise building is a static non-linear analysis under permanent 

vertical loads and monotonically increasing transverse loads. The equivalent static transverse 

loads represent earthquake induced forces.  Premature  failure can be represented by A graph 

of the total base shear vs top displacement in a building .failure can be analyzed by this 

method .Analysis is done upto failure. Thus collapse load and ductility capacity can be 

determined by pushover analysis.   In pushover analysis plastic rotation is monitored. The 

lateral inelastic forces vs displacement graph of the complete building is computed. This 

analysis is helpful in weakness in building to be identified. To make the decision to retrofit 

can be done in such studies. The earthquake design can be done as a two step process. The 

first one which is basically most important , is the concept of an effective structural system 

that needs to be configured with due care to all very important earthquake performance 

targets, ranging from serviceability considerations. The thumb rules for the strength and 

stiffness goals is based on the understanding of ground motion, elastic and inelastic dynamic 

response characteristics, should to be enough to configure and rough-size an effective 

structural system. Detailed mathematical or physical models can only be made when  a 

structural system has been created. Such models are needed to evaluate earthquake 

performance of an existing building.  They also improve component behavior characteristics 

(stiffness, strength, deflection capacity) for better fit the specified performance conditions. 

The 2
nd

 step consists of the design process that contains demand/capacity evaluation at all 

important capacity parameters, as well as the prediction of demands imposed by ground 

motions.. The distribution of design forces are based on initial estimate of   stiffness and as     

stiffness is dependent on the strength of elements, this cannot be know until the design 

process is complete. Distribution of seismic forces between elements based on initial stiffness 

is illogical, as it incorrectly assumes different elements can be forced to yield simultaneously 

 

1.2 Statement of the problem: 

 The distribution of design forces are based on initial estimate of   stiffness and as     

stiffness is dependent on the strength of elements, this cannot be known until the 

design process is complete 

 The distribution of design forces are based on initial estimate of   stiffness and as     

stiffness is dependent on the strength of elements, this cannot be known until the 

design process is complete. 
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  Distribution of seismic forces between elements based on initial stiffness is   

illogical, as it incorrectly assumes different elements can be forced to yield 

simultaneously 

1.3 Objectives 

 Identification of the critical regions in which the deformation demands are expected 

to be high and that have to become the focus through detailing.  

 

 Identification of the strength discontinuities in plan elevation that will lead to changes 

in the dynamic characteristics in elastic range.  

 

 Estimates of the inter story drifts that account for strength or stiffness discontinuities 

and that may be used to control the damages and to evaluate P-Delta effects.  

 

                                                        Work flow chart  

 

                                                                Figure 3 

 

 

Linear   static analysis  of existing building without earthquake. 

Linear   dynamic analysis of existing building using response spectrum 
method 

Linear  dynamic analysis of strengthened building using response 
spectrum analysis. 

Static pushover analysis of existing building in SAP2000 using 
FEMA approach with ATC-40 method .  

Static pushover analysis of strengthened building in  

SAP2000 using FEMA approach 

Non linear static time history analysis of existing building 

Non linear static time history analysis of strengthened building.  
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CHAPTER 2 

2.1Litrature review 

Appropriate capacity parameters and their permissible values, as well as suitable methods for demand 

prediction will depend on the performance level to be evaluated. The application of this solution 

requires the availability of as set of ground motion records (each with three components) that account 

for the uncertainties and differences in severity, frequency characteristics, and duration due rapture 

characteristics distances of the various faults that may cause certain ground motions at the field 

condition. It needs further the ability to model adequately the cyclic load-deflection characteristics of 

all important components of the three dimensional soil foundation structural system, and the 

availability of efficient tools to apply the solution process within the time and economical constraints 

on an technical problem. 

2.1.1Analysis methods 

 

 

The pushover is expected to provide information on many response characteristics that cannot be 

obtained from an elastic static or dynamic analysis. The following are the examples of such response 

characteristics:   

• The realistic force demands on potentially brittle elements, such as axial force demands on columns, 

force demands on brace connections, moment demands on beam to column connections, shear force 

demands in deep reinforced concrete spandrel beams, shear force demands in unreinforced masonry 

wall piers, etc.  
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• Estimates of the deflections demands for elements that have to form in-elastically in order to 

dissipate the energy imparted to the building.  

• Consequences of the strength deterioration of individual elements on behavior of structural system.  

• For location of the critical regions in which the deflection demands are expected to be high and that 

have to become the focus through detailing.  

• For location of the strength discontinuities in plan elevation that will lead to changes in the dynamic 

characteristics in elastic range.  

• Estimates of the inter-story drifts that account for strength or stiffness discontinuities and that may 

be used to control the damages and to evaluate P-Delta effects.  

• Verification of the completeness and adequacy of load path, considering all the elements of the 

structural system, all the connections, the stiff nonstructural elements of significant strength, and the 

foundation system.  

   The last item is the most relevant one as the analytical model incorporates all elements, whether 

structural or non structural, that contribute significantly to the lateral load distribution. Load transfer 

through across the connections through the ductile elements can be checked with realistic forces; the 

effects of stiff partial-height infill walls on shear forces in columns can be evaluated; and the 

maximum overturning moment in walls, which is often limited by the uplift capacity of foundation 

elements can be estimated.  These benefits come at the cost of the additional analysis effort, 

associated with incorporating all important elements, modeling their inelastic load-deflection 

characteristics, and executing incremental inelastic analysis, preferably with three dimensional 

analytical models.  

2.1.2Target Displacement  

The fundamental question in the execution of the pushover analysis is the magnitude of the target 

displacement at which earthquake performance evaluation of the building is to be performed. It is the 

roof displacement at the center of mass of the building. In the pushover analysis it is assumed that the 

target displacement for the MDOF building can be estimated as the displacement demand for the 

corresponding equivalent SDOF system transformed to the SDOF domain through the use of a shape 

factor. Inherent in this approach is the assumption that the maximum MDOF displacement is 

controlled by a single shape factor without regards to higher mode effects.  Under the Non-linear 

Static Procedure, a model directly incorporating inelastic material response is displaced to a target 

displacement, and resulting internal deflections and forces are determined. The mathematical model 

of the building is subjected to monotonically increasing lateral forces or displacements until either a 

target displacement is exceeded, or the building collapses. The target displacement is intended to 

represent the maximum displacement likely to be experienced during the design earthquake. 



8 
 

 

CHAPTER 3 

3.1Methology 

Earthquake analysis of buildings can be categorized depending upon the sophistication of modeling 

adopted for the analysis. Buildings loaded beyond the elastic range can be analyzed using Non-Linear 

static analysis, but in this method one would not be able to capture the dynamic response, especially 

the higher mode effects. This is pushover analysis. There is no specific code for NLSA. This 

procedure leads to the capacity curve which can be compared with design spectrum/DCR of members 

and one can determine whether the building is safe or needs strengthening and its extent. The capacity 

of building is represented by pushover curve. The most convenient way to plot he load deflection 

curve is by tracking the bas shear and the roof displacement. The pushover procedure can be 

presented in various forms can be used in a variety of forms for the use in a variety of methodologies. 

As the name implies it is a process of pushing horizontally, with a prescribed loading pattern, 

incrementally, until the building reaches the limit state. There are several types of sophistication that 

can be used over for pushover curve analysis.    

Level-1: It is generally used for single storey building, where at a single concentrated horizontal                         

force equal to base shear applied at the top of the building and displacement is obtained.  

Level-2: In this level, lateral force in proportion to storey mass is applied at different floor levels in 

accordance with IS:1893-2002 (Part-I) procedure, and story drift is obtained.  

Level-3:   In this method lateral force is applied in proportion to the product of storey masses and first 

mode shape elastic model of the building. The pushover curve is constructed to represent the first 

mode response of building based on the assumption that the fundamental mode of vibration is the 

predominant response of the building. This procedure is valid for tall buildings with fundamental 

period of vibration upto 1 sec.  

Level-4: This procedure is applied to soft storey buildings, wherein lateral force in proportion to 

product of storey masses and first mode of shape of elastic model of the building, until first yielding, 

the forces are adjusted with the changing the deflected shape.  

Level-5:  This procedure is similar to level 3 and level 4 but the effect of higher mode of vibration in 

determining yielding in individual structural element are included while plotting the pushover curve 

for the building in terms of the first mode lateral forces and displacements. The higher mode effects 

can be determined by doing higher mode pushover analysis. For the higher modes, building is pushed 

and pulled concurrently to maintain the mode shape. 
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3.2Limitations of Non-Linear Static Analysis  

There are many unsolved issues that need to be addressed through more research and development. 

Examples of the important issues that need to be investigated are:  

1. Incorporation of torsional effects (due to mass, stiffness and strength irregularities).  

2. 3-D problems (orthogonality effects, direction of loading, semi-rigid diaphragms, etc)  

3. Use of site specific spectra.  

4. Cumulative damage issues.  

5. Most importantly, the consideration of higher mode effects once a local mechanism has formed.  

Since the pushover analysis is approximate in nature and is based on static loading, as such it cannot 

represent dynamic phenomena with a large degree of accuracy. It may not detect some important 

deflection modes that occur in a building subjected to severe earthquakes, and it may significantly 

from predictions based on invariant or adaptive static load patterns, particularly if higher mode effects 

become important. 

Time history analysis is the use of an earthquake time history to evaluate the response of your system. 

Can be performed for both buildings and soil. Ideally, we want to use time histories that are 

reasonably close to our design response spectrum  Target Spectrum. 

3.3Time History Analysis 

There are two main methods we use to get our time histories to match the design spectrum: 

1. Time History Scaling 

2. Spectral Matching 

3.3.1Time History Scaling 

Time history scaling involves modifying a time history’s scale and/or time step in order to try to 

closely match the design response spectrum. In addition, we try to make the smoothed average 

spectrum fall within a specified tolerance of the target spectrum. Because it’s impossible to get this 

tolerance over the entire spectrum, we typically focus on the period range of interest: Often 0.2TN to 

1.5TN Advantages: 

1) Uses “Real” EQ Time histories 

2) Retains natural variances in the EQ time histories 3) Allows you to focus response on the period(s) 

of interest 
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4) Relatively easy to do with proper tools 

Disadvantages: 

1) Usually requires LOTS of time histories 

2) Greater variance in your computed response 

3) Can take a lot of time to do. 

3.3.2Spectral Matching 

Spectral matching involves a time domain modification of an acceleration time history to make it 

compatible with a user-specified target spectrum. Abrahamson (1993) wrote the first widely-used 

computer code for spectral matching called RSP Match. It has been subsequently updated. Spectral 

matching has the advantage of significantly reducing variability in the computed response because the 

time histories are often very close to the target response spectrum. 

Advantages: 

1) Less variability 

2) Usually requires fewer   ground motions 

3) Sometimes easier to spot design flaws from the system response 

Disadvantages: 

1) Can result in unrealistic EQ ground motions 

2) Certain valuable aspects of EQ time history can be lost  

3) Can take a lot of time to do correctly 

4) Easy to screw up if you don’t know what you’re doing 

Selecting Time Histories 

Part of the challenge of developing time histories is selecting appropriate time histories to use.  

What kinds of factors should we consider when selecting time histories?  

 Magnitude (within ± 1 Mag)  

 Distance (within ±10 km if possible)  

 Faulting mechanism (more important for reverse/thrust faults, subduction zones)  

 Spectral Acceleration (within 20-30% at the natural period(s) of interest, if possible)  

 Soil/Rock Type (same site class)  

 Directivity effects (if applicable) 



11 
 

CHAPTER 4 

 

4.1 Project part 1 

Modeling with E -Tabs  

This work presents the analysis of a framed building (G+10) is analyzed using E-Tabs. This 

research work is an approach, to study the effect on the lateral forces on the response of a 3-D 

framed building, when it is subjected to seismic forces. The analysis method used in E-Tabs, 

is the Response Spectrum Method conforming to IS 1893:2002. E-TABS is equipped with 

advanced finite element method and dynamic analysis capabilities. It features rapid analysis, 

and visualization tools. A G+10 storey building              was analyzed for all possible 

load combinations (i.e live load, dead load, earthquakes loads).  E-Tabs is user friendly and 

allows us to easily draw a frame, assign dimensions and thus input geometrical properties of 

all components along with definition of loads. Then as per the assigned specifications, we 

analyze the RCC frames.The loads to which the structure was subjected were, Dead load, 

Live load and Seismic loads, which had their calculation basis same as mentioned in IS 875 

(Part 1): 1987 and IS1893 (Part 1): 2002 . The dimensions were assigned to the columns and 

the beams along with the material specification. The supports at the base of the building are 

fixed and the code of practice, for the analysis in E-Tabs is defined. Thereafter, the program 

is run for analysis. It is the post processing mode by which, the deflection of the members is 

studied, taking into account a suitable load combination.  

4.2Load type 

 4.2.1 Dead Load 

The dead load comprises of weight due to all structural components of a structure in other 

words these are the permanent parts of the construction work or rather remain always with 

the structure. The dead consists of self weight of all structural components like floor, walls, 

beams, columns, roof etc. also floor finishes, false ceilings, false doors and other permanent 

constructions in the structure. The unit weight of RCC and Plain concrete made with sand 

and gravel or crushed natural aggregate are 25 KN/mm
2
 and 24 KN/mm

2
 respectively as per 

IS 875. 

4.2.2 Imposed Load 
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 It includes weight of furniture, mobile partitions, vibratory effects, impact loads, point loads 

and uniform loads. 

4.2.3 Earthquake Load 

Design Lateral Force: The lateral seismic force is evaluated for the building as a whole. This 

force shall then be used for the design of the entire structure. The floor diaphragm action 

further decides its distribution to horizontal load resisting components. Design Seismic Base 

Shear: The summation of all design lateral seismic forces at the base of the building is 

referred to as the Design Seismic Base Shear (VB). The expression for this force as given in 

IS 1893(Part 1) : 2002, clause no. 7.5.3 is : 

VB = AhW 

Where,                                                                                                                                                                                                                                                                                

Ah = Design horizontal acceleration spectrum, using the fundamental natural period Ta , in 

the direction under consideration. 

W = Seismic Weight of the Building. 

4.2.4 Fundamental Natural Period 

It is the time period with long modal vibration period. The fundamental natural period of 

vibration (Ta), in seconds of a moment resisting frame building without brick infill is given 

as:      

 

Ta = 0.075 h
0.75             

    for RCC frame building 

    = 0.085 h
0.75

            for steel frame building  

Where,  

h = height of the building which does not include the basement walls connected to columns 

of the building or to the ground floor deck. The inclusion of the basement storeys is when 

they are not connected this way. 

      In case of moment resisting frame with brick infill, the evaluation of the fundamental 

period is done by the following empirical formula given in the IS code: 

Ta = 0.09 
 

  
 

Where, 

h = height of the building in mm 
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d = base dimension of the building at the plinth level, in the direction of considered 

horizontal seismic force. 

4.2.5 Distribution of Design Force 

The distribution of base shear at different heights of the building is given by the following 

expression, as per IS 1893:2002. 

Pi = VB 
    

 

  
    

 
         

Where,  

Pi = Design lateral force at i
th 

floor, 

Wi = Seismic weight of i
th

 floor, 

hi = i
th

 floor height from the base, 

n = no. of storeys in the building, where the weights are positioned. 

4.2.6 Dynamic Analysis 

The buildings for dynamic analysis are: 

a) Regular Buildings: Frame buildings exceeding the height of 40 m in seismic Zones IV and 

V and the ones in Zones II and III with height greater than 90 m. 

b) Irregular Buildings: Frame building in Zones IV and V with height greater than 12 m and 

with height more than 40 m Zones II and III. 

If there lies irregularities in the design of a building then the analytical model thus framed for 

the prototype shall represent it accurately. Buildings that are not regular in plan cannot be 

analyzed for dynamic analysis. Dynamic method for frame buildings can be carried out by 

Response Spectrum Method or Time History Method.  

  

4.3 Analytical study of G+10 framed building  

In the present study a G+10 Storey framed building has been analyzed. The following screen 

shots have been taken from E-TAB.   

4.3.1 Characteristics of the Framed Building 

Plan view and elevation view 
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                         Figure4 and figure 5: Plan and elevation  of a G+10 storey framed building  

 

4.3.2 Defining Sectional Properties 

Member property could be generated in E-Tabs. by using the sub tab “property” in the 

window of the program.  

4.3.2.1Specifications of existing building 

Table 1 

Member Size 

Column 1 900*700mm up to 5
th
 storey 

Column 2 600*500mm above 5
th
 storey 

Beam 500*300mm 

Slab 150mm 

Wall 230mm 
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Column 1(reinforcement) 7 nos. in x-direction, 9 nos. in y-direction 

Column 2(reinforcement) 4 nos. in x-direction, 6 nos. in y-direction 

 

 

 

Column 1 

 

900*700mm up to 5
th
 storey 

Column 2 600*500mm above 5
th
 storey 

Beam 400*300mm 

Slab 150mm 

Wall 230mm 

Column 1(reinforcement) 7 nos. in x-direction, 9 nos. in y-direction 

Column 2(reinforcement) 4 nos. in x-direction, 6 nos. in y-direction 

 

 

 

                                                            Figure 6 
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COLUMNS: 

  

                                                          Figure 7 

Slab and wall thickness: 

   

                                                   Figure 8 and figure 9 
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Material properties: concrete M25 Grade, bending reinforcement Fy500, shear 

reinforcement Fy  415  

con 

 

                                                                    figure 10 
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4.3.3 Assigning Supports 

The base of the building is provided with a fixed support. This fixed support is assigned to 

the building. 

 

             Figure 11: Fixed supports at the base. 

 

4.3.4 Generation of Loads 

Loads are assigned to the structure and its members by using the load generator in E-Tabs. In  

E-Tabs the categories of load are defined. The types of loads which has been used in analysis 

are as following- 

a. Dead load. 

b. Live load. 

c. Slab load. 

d. Wall load. 

e. Earthquake Load. 

f. Wind load.  
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Load cases: 

Table 2:  Load Pattern Definitions 

   

LoadPat  Design Type  Self WtMult Auto Load 

      

DEAD  DEAD  1.000000  

LIVE  DEAD  0.000000  

WALL  SUPER DEAD  0.000000  

FF  SUPER DEAD  0.000000  

EQXPY  QUAKE  0.000000 IS1893 2002 

EQYPX  QUAKE  0.000000 IS1893 2002 

WX  WIND  0.000000 IS875 1987 

WY  WIND  0.000000 IS875 1987 

SLAB  SUPER DEAD  0.000000  

 

4.3.5 Dead load 

The dead load comprises of weight due to all structural components of a structure. 

4.3.6 Live Load: 

The live load applied on the framed building is of different intensities. Live load on roof is 3 

kN/m . Floor finishing load  1.5 KN/m
2
.  

 

Table 3:  Auto Wind - IS875-1987, Part 1 of 2  

Load Pat  Angle  Wind ward 

Cp 

 

 

Lee ward 

Cp 

 Wind Speed 

  Degrees      meter/sec 

WX  0.000  0.800000  0.500000  50.000 

WY  0.000  0.800000  0.500000  50.000 

 

 

 

Table 4:  Auto Wind - IS875-1987, Part 2 of 2 

Load Pat  Terrain 

Cat 

 Struct Class k1  k3 

        

WX  2  B 1.000000  1.000000 

WY  2  B 1.000000  1.000000 
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Table 5:  Auto Seismic - IS1893:2002, Part 1 of 2 

Load Pat  Dir  Percent  

Ecc 

Z Code  Soil Type 

        

EQXPY  X  0.050000 0.24  II 

EQYPX  Y  0.050000 0.24  II 

 

 

Table 6:  Auto Seismic - IS1893:2002, Part 2 of 2 

Load Pat  I  R  T Used  Coeff 

Used 

 Weight 

Used 

Base Shear 

      Sec    KN KN 

EQXPY  1.000000  5.000000  0.9610  0.707596  51138.006 1736.883 

EQYPX  1.000000  5.000000  0.9610  0.707596  51138.006 1736.883 

 

4.3.7 Slab load 

Self weight is generated by the software itself by defining the primary load case as the slab 

weight in the “load & definition” tab.  

4.3.8 Wall Load 

 Loading due to wall is distributed to the members .It is taken by software it  self. 

4.3.9 Seismic Load 

The earthquake forces are calculated following the guidelines, mentioned in IS 1893(Part 

I):2002. The software can generate seismic force provided that, the code which is to be 

followed, is defined. The lateral seismic forces are generated in the two horizontal directions 

i.e. X and Z directions. The Base Shear calculated by the E-Tabs is as per the IS code:  

VB = AhW 

Where,                                                                                                                                                                                                                                                                            

Ah = Design horizontal acceleration spectrum, using the fundamental natural period Ta, in the 

direction under consideration. 

W = Seismic Weight of the Building. 

4.3.10 Load Combination 

The analysis of the structure proceeds with the consideration of the load 

combinations. The various loads like the dead load, live load, wall loads, seismic 

loads etc. are considered in a proper proportion and thus the structure is analyzed 

using the load cases which are the combinations of these.  

Load combination data: 
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Figure12: Primary load combinations 

 

Reduction factor for loads: 

 

                                                         Figure 13 

4.4Project Part 2 

4.4.1Procedure of Non-Linear Static Analysis using SAP 2000  

The recent advent of performance based design has brought the nonlinear static pushover analysis 

procedure to the forefront. Pushover analysis is a static, nonlinear procedure in which the magnitude 

of the structural loading is incrementally increased in accordance with a certain predefined pattern. 

With the increase in the magnitude of the loading, weak links and failure modes of the building are 

found. The loading is monotonic with the effects of the cyclic behavior and load reversals being 

estimated by using a modified monotonic force-deflection criteria and with damping approximations. 

Static pushover analysis is an attempt by the structural engineering profession to evaluate the real 

strength of the building and it promises to be a useful and effective tool for performance based design.   

The ATC-40 and FEMA-273 documents have developed modeling procedures, acceptance criteria 

and analysis procedures for pushover analysis. These documents define force deflection criteria for 

hinges used in pushover analysis. As shown in Figure 1, five points labeled A, B, C, D, and E are used 
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to define the force deflection behavior of the hinge and three points labeled IO, LS and CP are used to 

define the acceptance criteria for the hinge. (IO, LS and CP stand for Immediate Occupancy, Life 

Safety and Collapse Prevention respectively.) The values assigned to each of these points vary 

depending on the type of member as well as many other parameters defined in the ATC-40 and 

FEMA-273 documents.   

This article presents the steps used in performing a pushover analysis of a simple three dimensional 

building. SAP2000, a state-of-the-art, general-purpose, three-dimensional structural analysis program, 

is used as a tool for performing the pushover. The SAP2000 static pushover analysis capabilities, 

which are fully integrated into the program, allow quick and easy implementation of the pushover 

procedures prescribed in the ATC-40 and FEMA-273 documents for both two and three-dimensional 

buildings.   

Step-1 Linear Analysis & Unlock the Model 

Design the building as per linear analysis using expected strength and modified partial safety 

factors. After completing the design of the building Unlock the model as shown in Figure 14.  

 

 

 

                                               Figure 14: Unlock Model Form 
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Step-2 Define New Load Case of Gravity Loads 

Go to Define > Load Case> Add New Load Case consisting of Gravity loads (i.e. dead load 

and % of live load). This load case consists of force controlled loads as shown in Figure 15 

since load application type is full load.  

 

 

 

 

 

   

 

 

 

                                                                      

                                                                    

 

 

 

 

 

 

 

 

 

 

                                                             Figure 15 

Select Load Case Type > Static, Analysis Type> Nonlinear and Geometric Non-linearity 

Parameters as P-Delta. The non-linear parameters (other parameters as shown in Figure 15) 

should not be changed in gravity load case. It will start from zero initial stiffness.  

Step-3 Assignment of Hinges to Frame Elements 

Select all the beams in the model. Go to Assign > Frame > Hinges. The hinge form will 

appear as shown in Figure 16 
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                                                         Figure 16: Hinge Assignment Form 

 

Add hinges to the selected beams the hinge type form will appear as shown in Figure 16. 

 

                               Figure 17 

 The hinges should be assigned at both the ends which means at the relative distance of 0 and 

1 and form as shown in Figure 17 will appear. In similar manner assign hinges to all columns 

by repeating steps as previously carried out for beams the only difference is that column 

should be assigned P-M2-M3 hinges instead of M3 hinges as shown in Figure 17. 
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  Figure 18: Hinge Properties for Beams Form 

 

The hinges should be assigned at both the ends which means at the relative distance of 0 and 

1 and form as shown in Figure 19 will appear.  

 

 

 

 

 

 

 

 

 

Figure 19:Hinge at both ends Form for Column 

Step-4 Define Pushover load Case 

Go to Define > Load Case> Add New Load Case >PUSH consisting of load in proportion to 

the fundamental mode. This load case is deformation controlled load case as shown in Figure 

20.  

 

 

 

 

 

 

   Figure 20:Pushover Load Case Form 
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Select Load Case Type> Static, Analysis Type> Nonlinear and Geometric Non-linearity 

Parameters as P-Delta. This load case should be started from a previous load case Gravity 

since gravity load will always be acting on the structure. Select Loads Applied proportional 

to Mode in the considered direction of the analysis. The scale factor for this load case should 

be kept equal to 1. In pushover load case for other parameters, to modify the displacement 

upto which the force-deformation curve needs to be monitored click Modify and the load 

application control for non-linear static analysis form will appear as shown in Figure 9. In the 

non-linear load application control parameters Load Application should be Displacement  

control  with  Monitored  Displacement.  Generally, the  monitored displacement is kept 

equal to 2% of the height of the building. This displacement should be monitored in the 

considered direction of analysis (i.e. either U1 or U2 degree of freedom). The joint at which 

the force deformation curve is monitored is generally taken as at the Centre of mass of the 

building.Displacement is kept equal to 2% of the height of the building. This displacement 

should be monitored in the considered direction of analysis (i.e. either U1 or U2 degree of 

freedom). The joint at which the force deformation curve is monitored is generally taken as at 

the Centre of mass of the building 

 

 

 

 

 

 

 

                          Figure 21: Load Application Control for Non-Linear Static Analysis Form 

 

 

 

 

 

 

 

 

 

 

                          Figure 22 : Results Saved for Non-Linear Static Load Case Form 
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In pushover load case for other parameters, to modify the steps at which results needs to be 

saved click Modify the results saved for non-linear static load case form will appear as shown 

in Figure 23. In this form Multiple Steps should be selected in order to save the results at the 

intermediate steps. In this form for each stage Minimum and Maximum number of saved 

steps should be kept 1000 and 5000 in order to avoid solution converge. In pushover load 

case for other parameters, the non-linear parameters should be by Default. If convergence 

problem occurs than Number of Null Steps and Number of Constant Stiffness Iteration 

should be increased. For unloading the hinge, Unload Entire Structure method should be used 

as shown non-linear parameter form in Figure 24. The hinge unloading method controls the 

time requirements for completing the analysis. The Local Redistribution method is the Fastest 

while the Unloading Entire Structure method is the Slowest. It is important to note that the 

non-linear parameters affect the solution control; hence the results obtained using different 

solution control parameters and Hinge unloading method may deviate slightly, hence no 

unique solution is obtained for some problems. 

 

 

 

 

 

 

 

 

 

                                             Figure 23: Non-Linear Parameters Form 

 

Step-4 Run Analysis 

While running the analysis it is important to Run the Modal and Gravity analysis with 

pushover load case since Pushover load case takes stiffness from gravity load case and mode 

shape from Modal load case. While the SAP 2000 is analyzing the structure the analysis 

monitor form as shown in Figure 24 will appear. After completing the analysis the analysis 

complete form as shown in Figure 25 will appear. The pushover analysis is a non-linear static 

analysis so depending upon system configuration it takes time to complete the analysis.  

 

 

 



28 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 24: Analysis Monitor Form 

 

 

 

 

 

 

 

 

                                                  

 

 

 

 

 

 

 

 

 

                                                 Figure 25: Analysis Complete Form 
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Step-5 Graphically review the pushover analysis results 

To  see  the  pushover  curve  Go  to  >  Display  >  Show  Static  Pushover  Curve,  the 

display static pushover curve form as shown in Figure 26.The Static Pushover Curve will 

appear as shown in Figure 26. Go to > File > Display Tables it will show the results of 

Pushover analysis in Tabular Form.  

 

 

 

 

 

 

 

 

 

 

 

                                           Figure26: Display Static Pushover Curve Form 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                             Figure 27 

 

To see the deformed shape under pushover load case and hinges at any step, Go to Display> 

Show Deformed Shape> Select load case> PUSH. The deformed shape form will appear as 
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shown in Figure 28.  

 

In deformed shape form the step at which the result is to be seen should be given. For the 

result at last step it should be 1000 and deformed shape of structure at that step is as shown in 

Figure 29. 

  

 

 

 

 

 

 

 

 

                                     

 

                                         

                                       

                                                   Figure 28: Deformed Shape Form 

 

    

 

Figure 29: Deformed Shape at Last Step 
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   To see the hinge results Right Click on Hinge the hinge results will appear as shown in Figure 30. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 30 Hinge Result 

         

In order to perform the time history analysis the step 1 to step 3 should be repeated as discussed above. 

 

Step-6 Define time history 

Go to Define > Functions> Time History the following form will appear as shown in Figure 31. In this form 

choose function type to add from file. 

 

 

 

 

 

 

 

 

  

Figure31 
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Go to Add New Function and add the time history file from system in text format and convert it to user defined 

than time history file form will appear as shown in Figure 32





. 

 

 

 

 

 

 

 

 

Figure 32: Time History Function Definition 

 

Step-7 Define time history load case 

 

Go to Define > Load Case> Add New Load Case >TH consisting of time history load case and the time history 

load case form will appear as shown in Figure 33. 

 

 

 

 

 

 

 

 

                                                        Figure 33 :Time History Load Case Form 

 

Select Load Case Type> Time History, Analysis Type> Nonlinear, Time History Type> Direct Integration and 
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Geometric Non-linearity Parameters as P-Delta. This load case should be started from a previous load case 

Gravity since gravity load will always be acting on the structure. Select Loads Applied > Acceleration in the 

considered direction (i.e. either U1 or U2 degree of freedom) of the analysis. The scale factor for this load case 

should be kept equal to 1or 9.81 depending upon the input time history file whether provided in units of g or 

m/s
2
, respectively. 



 

 

 

 

 

 

 

 

                         Figure 34:  Mass and Stiffness Proportional Damping Form 

 

In Time History Load Case for other parameters, to modify the damping which needs to be considered click 

Modify and mass and stiffness proportional damping form will appear as shown in Figure 35. It is important to 

note that when damping is specified it is specified by period and period corresponding to 1
st
 and 3

rd
 mode of 

vibration in the considered direction of analysis should be used. The damping used should be equal to 2%, 5% 

and 10% for Steel, RC and Masonry buildings, respectively. In Time History load case for other parameters, to 

modify the time integration technique to be considered click Modify and time integration parameter form will 

appear as shown in Figure 35. The Hilber-Hughes-Taylor method of time integration should be used with alpha 

as zero and if convergence does not occur than alpha equal to minus 0.33 should be used. 

 

 

 

 

 

 

 

           Figure 35: Time Integration Parameters Form 

In Time History Load Case for other parameters, the non-linear parameters should be set to default. After 
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defining Time History Load Case, Run the analysis.The non-linear time history analysis is a time consuming 

analysis and depending upon the size of the problem it takes large amount of time as well as space for 

completion of the analysis.  

Step-8 Graphically review the time history analysis results 

The deformed shape and hinge pattern at any instant can be viewed in similar manner as viewed in case of 

pushover analysis. The peak displacement during time history analysis can be viewed through plot function. Go 

to > Display > Show Plot Functions and define the plot function i.e. joint whose displacement is required. The 

Figure 36 shows the plot functions for the joint displacement for the time history load case. 

 

 

 

 

 

 

 

 

 

 

                                              Figure 36 :Plot Function for Joint 3 Displacements 
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CHAPTER 5 

5.1Results 

On the above building frame the non linear static pushover  analysis is performed to investigate the performance 

point of the building frame in terms of base shear and displacement. For pushover analysis the various pushover 

cases are considered such as push gravity, push X ( i.e. loads are applied in X direction), push Y (i.e. loads are 

applied in Y direction). The various load combinations are also used for this purpose. After pushover analysis the 

demand curve and capacity curves are obtained to get the performance point of the structure. The performance point 

is obtained as per ATC 40 capacity spectrum method. The base shear for PUSH X load case is (904.612 KN). And 

for PUSH Y base shear at performance point is (915.197) as shown in figure 

Column interaction curves and tables: 

Table 7 

 

Curve 1 0. degrees

P M3 M2

-3810.3 0 0

-3511.06 147.9328 0

-3099.22 195.128 0

-2517.27 250.8787 0

-1674.35 314.8028 0

-612.957 382.123 0

127.0696 386.7478 0

834.2274 361.1915 0

1662.192 275.0303 0

2655.853 132.1866 0

3492.041 0 0   

 

                           Figure 37 
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Table 8: 

Curve 2 15. degrees

P M3 M2

-3810.3 0 0

-3810.3 117.4401 21.5068

-3263.16 167.8358 26.8775

-2645.34 224.1198 33.7359

-1811.12 286.5337 40.7831

-604.55 354.7683 50.3025

298.0932 353.4224 50.6083

1208.793 301.5445 52.476

2191.1 194.1542 45.665

3249.103 38.5784 25.1397

3492.041 0 0  
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                                 Figure 38 
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Table 9 

 

Curve 3 30. degrees

P M3 M2

-3810.3 0 0

-3810.3 99.3414 36.8919

-3384.4 141.047 51.1633

-2740 194.043 65.8957

-1846 251.394 82.8778

-566.68 304.501 102.069

515.542 307.873 101.008

1531.83 247.027 95.5849

2548.06 134.352 73.5455

3287.81 32.1687 21.6891

3492.04 0 0  

 

 

                                 Figure 39 

Table 10 

Curve 4 45. degrees

P M3 M2

-3810.3 0 0

-3810.3 81.1813 52.9308

-3425.61 114.1201 74.7396

-2788.53 158.0658 99.6959

-1855.68 207.3965 126.858

-513.94 249.5861 154.9376

615.5763 246.8412 158.9419

1690.337 200.926 130.4128

2647.731 115.0349 76.639

3316.568 27.5675 18.7938

3492.041 0 0  
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Curve 3 P 
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                                          Figure 40 

Table 11 

Curve 5 60. degrees

P M3 M2

-3810.3 0 0

-3810.3 59.7368 71.5918

-3424.97 86.1574 98.111

-2786.26 117.4013 134.0994

-1824.96 149.7527 174.5037

-471.643 184.4768 212.721

638.9825 182.0104 214.7496

1645.874 157.0087 167.1303

2676.669 97.7512 86.2232

3344.638 23.1146 15.9504

3492.041 0 0  

 

                                     

                                               Figure 41 
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Table 12 

Curve 6 75. degrees

P M3 M2

-3810.3 0 0

-3810.3 36.5504 91.4335

-3320.87 49.1761 129.1021

-2676.62 62.649 176.3359

-1772.67 80.6622 226.6884

-463.69 103.3424 281.1802

455.6915 95.0449 279.7358

1270.447 95.9407 219.7757

2413.218 93.779 114.6648

3375.416 18.0684 12.9671

3492.041 0 0  
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                                               Figure 42 
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Table 13 

Curve 7 90. degrees

P M3 M2

-3810.3 0 0

-3416.06 0 126.0205

-2978.64 0 165.3185

-2343.66 0 215.5833

-1495.76 0 278.5432

-487.699 0 346.6093

-129.472 0 341.0493

612.6906 0 302.9814

1320.9 0 230.8886

3196.06 0 34.421

3492.041 0 0  

 

                                      Figure 43 

Table 14 

 

Curve 8 105. degrees

P M3 M2

-3810.3 0 0

-3810.3 -36.5504 91.4335

-3320.87 -49.1761 129.1021

-2676.62 -62.649 176.3359

-1772.67 -80.6622 226.6884

-463.69 -103.342 281.1802

455.6915 -95.0449 279.7358

1270.447 -95.9407 219.7757

2413.218 -93.779 114.6648

3375.416 -18.0684 12.9671

3492.041 0 0  
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                                Figure 44 

Table 15 

 

Curve 9 120. degrees

P M3 M2

-3810.3 0 0

-3810.3 -59.7368 71.5918

-3424.97 -86.1574 98.111

-2786.26 -117.401 134.0994

-1824.96 -149.753 174.5037

-471.643 -184.477 212.721

638.9825 -182.01 214.7496

1645.874 -157.009 167.1303

2676.669 -97.7512 86.2232

3344.638 -23.1146 15.9504

3492.041 0 0  
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Table 16 

Curve 10 135. degrees

P M3 M2

-3810.3 0 0

-3810.3 -81.1813 52.9308

-3425.61 -114.12 74.7396

-2788.53 -158.066 99.6959

-1855.68 -207.397 126.858

-513.94 -249.586 154.9376

615.5763 -246.841 158.9419

1690.337 -200.926 130.4128

2647.731 -115.035 76.639

3316.568 -27.5675 18.7938

3492.041 0 0  

 

                                       Figure 46 

Table 17 

Curve 11 150. degrees

P M3 M2

-3810.3 0 0

-3810.3 -99.3414 36.8919

-3384.43 -141.047 51.1633

-2740.04 -194.043 65.8957

-1846.04 -251.394 82.8778

-566.681 -304.501 102.0691

515.5423 -307.873 101.0081

1531.831 -247.027 95.5849

2548.06 -134.352 73.5455

3287.813 -32.1687 21.6891

3492.041 0 0  
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                                    Figure 47 

Table 18 

Curve 12 165. degrees

P M3 M2

-3810.3 0 0

-3810.3 -117.44 21.5068

-3263.16 -167.836 26.8775

-2645.34 -224.12 33.7359

-1811.12 -286.534 40.7831

-604.55 -354.768 50.3025

298.0932 -353.422 50.6083

1208.793 -301.545 52.476

2191.1 -194.154 45.665

3249.103 -38.5784 25.1397

3492.041 0 0  
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                                                   Figure 48 

Table 19 

Curve 13 180. degrees

P M3 M2

-3810.3 0 0

-3511.06 -147.933 0

-3099.22 -195.128 0

-2517.27 -250.879 0

-1674.35 -314.803 0

-612.957 -382.123 0

127.0696 -386.748 0

834.2274 -361.192 0

1662.192 -275.03 0

2655.853 -132.187 0

3492.041 0 0  

 

 

                                   

                                                Figure 49 
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Table 20 

Curve 14 195. degrees

P M3 M2

-3810.3 0 0

-3810.3 -117.44 -21.5068

-3263.16 -167.836 -26.8775

-2645.34 -224.12 -33.7359

-1811.12 -286.534 -40.7831

-604.55 -354.768 -50.3025

298.0932 -353.422 -50.6083

1208.793 -301.545 -52.476

2191.1 -194.154 -45.665

3249.103 -38.5784 -25.1397

3492.041 0 0  

 

                                     Figure 50 
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Table 21 

Curve 15 210. degrees

P M3 M2

-3810.3 0 0

-3810.3 -99.3414 -36.8919

-3384.43 -141.047 -51.1633

-2740.04 -194.043 -65.8957

-1846.04 -251.394 -82.8778

-566.681 -304.501 -102.069

515.5423 -307.873 -101.008

1531.831 -247.027 -95.5849

2548.06 -134.352 -73.5455

3287.813 -32.1687 -21.6891

3492.041 0 0  

 

 

                                  Figure 51 

Table 22 

 

Curve 16 225. degrees

P M3 M2

-3810.3 0 0

-3810.3 -81.1813 -52.9308

-3425.61 -114.12 -74.7396

-2788.53 -158.066 -99.6959

-1855.68 -207.397 -126.858

-513.94 -249.586 -154.938

615.5763 -246.841 -158.942

1690.337 -200.926 -130.413

2647.731 -115.035 -76.639

3316.568 -27.5675 -18.7938

3492.041 0 0  
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                                           Figure 52 

Table 23 

Curve 17 240. degrees

P M3 M2

-3810.3 0 0

-3810.3 -59.7368 -71.5918

-3424.97 -86.1574 -98.111

-2786.26 -117.401 -134.099

-1824.96 -149.753 -174.504

-471.643 -184.477 -212.721

638.9825 -182.01 -214.75

1645.874 -157.009 -167.13

2676.669 -97.7512 -86.2232

3344.638 -23.1146 -15.9504

3492.041 0 0  

 

                                 Figure 53 
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Table 24 

Curve 18 255. degrees

P M3 M2

-3810.3 0 0

-3810.3 -36.5504 -91.4335

-3320.87 -49.1761 -129.102

-2676.62 -62.649 -176.336

-1772.67 -80.6622 -226.688

-463.69 -103.342 -281.18

455.6915 -95.0449 -279.736

1270.447 -95.9407 -219.776

2413.218 -93.779 -114.665

3375.416 -18.0684 -12.9671

3492.041 0 0  

 

                                           Figure 54 

Table 25 

Curve 19 270. degrees

P M3 M2

-3810.3 0 0

-3416.06 0 -126.021

-2978.64 0 -165.319

-2343.66 0 -215.583

-1495.76 0 -278.543

-487.699 0 -346.609

-129.472 0 -341.049

612.6906 0 -302.981

1320.9 0 -230.889

3196.06 0 -34.421

3492.041 0 0  
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                                                                Figure 55 

Table 26 

 

Curve 20 285. degrees

P M3 M2

-3810.3 0 0

-3810.3 36.5504 -91.4335

-3320.87 49.1761 -129.102

-2676.62 62.649 -176.336

-1772.67 80.6622 -226.688

-463.69 103.3424 -281.18

455.6915 95.0449 -279.736

1270.447 95.9407 -219.776

2413.218 93.779 -114.665

3375.416 18.0684 -12.9671

3492.041 0 0  
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                                         Figure 56 

Table 27 

Curve 21 300. degrees

P M3 M2

-3810.3 0 0

-3810.3 59.7368 -71.5918

-3424.97 86.1574 -98.111

-2786.26 117.4013 -134.099

-1824.96 149.7527 -174.504

-471.643 184.4768 -212.721

638.9825 182.0104 -214.75

1645.874 157.0087 -167.13

2676.669 97.7512 -86.2232

3344.638 23.1146 -15.9504

3492.041 0 0  
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Table 28 

Curve 22 315. degrees

P M3 M2

-3810.3 0 0

-3810.3 81.1813 -52.9308

-3425.61 114.1201 -74.7396

-2788.53 158.0658 -99.6959

-1855.68 207.3965 -126.858

-513.94 249.5861 -154.938

615.5763 246.8412 -158.942

1690.337 200.926 -130.413

2647.731 115.0349 -76.639

3316.568 27.5675 -18.7938

3492.041 0 0  

 

                                            Figure 58 

Table 29 

 

Curve 23 330. degrees

P M3 M2

-3810.3 0 0

-3810.3 99.3414 -36.8919

-3384.43 141.0471 -51.1633

-2740.04 194.0429 -65.8957

-1846.04 251.3937 -82.8778

-566.681 304.501 -102.069

515.5423 307.8733 -101.008

1531.831 247.0267 -95.5849

2548.06 134.3524 -73.5455

3287.813 32.1687 -21.6891

3492.041 0 0  

-6000 

-4000 

-2000 

0 

2000 

4000 

1 2 3 4 5 6 7 8 9 10 11 

Curve 22 P 

315. degrees M3 

315. degrees M2 



52 
 

 

                                           Figure 59 

Table 30 

 

Curve 24 345. degrees

P M3 M2

-3810.3 0 0

-3810.3 117.4401 -21.5068

-3263.16 167.8358 -26.8775

-2645.34 224.1198 -33.7359

-1811.12 286.5337 -40.7831

-604.55 354.7683 -50.3025

298.0932 353.4224 -50.6083

1208.793 301.5445 -52.476

2191.1 194.1542 -45.665

3249.103 38.5784 -25.1397

3492.041 0 0  
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Table 31 

Period UX UY UZ

2.099255 0 82.4199 0

1.815391 81.6922 0 0

1.812479 0 0 0

0.695417 0 9.7496 0

0.600222 0 0 0

0.597712 9.9013 0 0

0.410147 0 3.4065 0

0.355381 0 0 0

0.348436 3.5018 0 0

0.290306 0 1.7429 0

0.250143 0 0 0

0.243419 1.842 0 0  

 

 

                        

                                         Figure 61 
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Push over capacity curve 

 

 

 

 

 

 

 

 

 

 

 

 

  

                                      

                       

                                                          Figure 62 

 

 

5.2Performance point 

 

The point at which the capacity curve intersects the reduced demand curve represents the 

performance point at which capacity and demand are equal. As displacement increase, the period 

of the structure lengthens and reduces demand. Hence, optimum point should have a higher 

capacity for a lesser displacement. 
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Lateral Force vs displacement  table and curve  

 

Table 32 

 

 

 

                                          Figure 63 
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Base shear : 

 

 

                                      Figure 64  
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CHAPTER 6 

6.1Conclusion 

 Building designed with IS 1893:2002 found to have a better performance under given 

earthquake. 



 The design base shear of the building frame is found to be 596.7 KN as per calculation. 

After performing the analysis the base shear at performance point is found to be 

1733.8KN which is greater than design base shear. Since at the performance point base 

shear is greater than the design base shear the building frame is safe under the earthquake 

loading. 

6.2 Future work  

 Time history analysis for actual behavior under earthquake on existing and strengthened 

building.  

 Comparison of existing and strengthened building at various performance levels using 

pushover and time history hinges results. 
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